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QUICK START

DevCom2000 Mobile uses Device Descriptions (DDs) to access data stored in the memory of the smart field
device. These DDs are developed by the manufacturer for their products and, in turn, distributed by the HART®
Communication Foundation (HCF) worldwide. The latest DDs are included as part of the DevCom2000 Mobile
installation. Visit the HCF website (www.hartcomm.org) or the ProComSol website (www.procomsol.com) for
update information.

The following steps will allow you to install and quickly begin using DevCom2000 Mobile:

Step 1: Install the DevCom2000 Mobile application

Insert the DevCom2000 Mobile SD Card into the SD slot of the Mobile device. Connect the Mobile to your PC and
verify the ActiveSync program is running.

Note: The step in this paragraph is only required if the SD Card is not supplied, but instead the DD Library is
supplied as a program install. When the DD library is installed, it is placed in the “C:\HCF\DDL\Mobile\Library”
directory on the PC. Copy the Library folder to the SD Card on the Mobile so that the path appears as “SD
Card\Library”. Please note that on some Mobile devices “SD Card” may have slightly different text. (Note: You
will overwrite the existing SD Card\Library subdirectory if this is an update.)

Insert the DevCom2000 Mobile installation CD into the CD drive on your computer. The DevCom2000 Mobile
installation will automatically start and guide you through the installation process. Install DevCom2000 Mobile in
its default location. If the installation program does not begin automatically, please go to Start->Run-> and enter
“CDRom drive letter’:\setup.exe. This will begin the installation program. After the install is finished on the PC,
select “Device” on the Mobile to finish installation. See Section 4.2 for details.

Step 2: Connect the communication interface

Connecting to a HART device requires special interface hardware to be attached to your computer. These
interfaces ("HART Modems") are available from ProComSol, Ltd and other sources. The interface should be
connected and configured. The preferred interface is a Bluetooth HART Modem - ProComSol, Ltd model HM-BT-
BAT-ER. See Section 4.4 for details.

Step 3: Connect to the field device

Find a connection point for the device’s 2-wire 4-20mA loop you wish to communicate with. For communications
you must have a suitable load resistance or a 250€2 resistor must be placed in series with the device. Using the clips
from the HART interface, connect to the HART device. While the HART Communication signal is available
anywhere along the 4-20mA wiring, it is often easiest to connect across the field device's terminals (caution should
be observed when working in a hazardous area, many Mobile’s are not rated for intrinsic safety and should only be
connected in a safe area).
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Step 4: Activate DevCom2000 Mobile
Launch DevCom2000 Mobile by selecting the DevCom2000 Mobile icon from the Start menu.

You will now be asked to Activate DevCom2000 Mobile. You can use it for 10 days before you need to Activate
it. Select “No” to continue in Demo mode. Activation only needs to occur once. See Section 4.3 for details.

On some Mobile devices another step is required in order to select the DD library location. This is only required if
the SD card has a name that is not standard. In this case a screen will come up where the user will need to select
the path of the DD Library in the Mobile device. The selection will appear in the box at the bottom of the screen.

Step 5: Browse the Device

Operating DevCom2000 Mobile is similar to working with Windows® Explorer. DevCom2000 Mobile
communicates to the field device, establishes a connection and learns its identity. Once DevCom2000 Mobile
knows its identity, DevCom2000 Mobile locates the device's DD and loads it. From this point forward operation of
DevCom2000 Mobile is determined by the DD provided by the product's manufacturer. If a DD for the device is
not present, a generic DD will be used.

By default, DevCom2000 Mobile will open the Browser window. The organization of the data in this explorer-
style window is dictated by the device DD. The top tree-pane of this window shows the logical groups of field
device data. These are called "Menus". The bottom data-pane shows the data, any sub-groups and any standard
operating procedures found on a given menu.

nn

You can browse through the field device data by expanding (click "+" symbol) or collapsing (click the "-" symbol)

the menus in the tree-pane. You can also double-click the folder symbol when seen on the data-pane.

Step 6: Modify the Device's Configuration

The Browser allows access to all of the data exactly as described by the product's manufacturer’s DD. When you
find elements of the field device's configuration you want to change, simply double-click and edit the data. Once

you have changed the configuration to suit your needs, press the Send icon B to commit the data and transfer it to
the field device.

Step 7: Performing Maintenance and Testing the Field Device

Many devices perform Methods or Standard Operating Procedures (SOPs) that may need to be performed to ensure
the device is in peak condition. These Methods may include calibrating the loop current, trimming the transducer
values or performing some diagnostic test on the field device. Methods appear in the data-pane just like data does.
Double-click on the Method and it will start running in a separate window. The Method will guide you through the
process ensuring the procedure is completely and consistently performed. When the Method is complete the
window will disappear.

Step 8: Exit
When you are through working on the field device simply exit DevCom2000 Mobile. Once the program exits, you
can then disconnect the HART interface hardware.

MAN-1017 8/9/2011 Our Quality Management System is Page 2
ISO 9001:2008 Certified



\,; PROCOMSOL

Process Communications Solutions

DevCom?2000 Mobile User Manual

Table of Contents
QUICK START ..ttt ettt ettt ettt e bt et e e st e s bt et e e st esseenbeentesseenbesseesaeensesneenseens 1
I INETOAUCTION ..ttt ettt ettt e et et esbe e e b e e sae e s teesateembeessneeneenanees 4
1.1 Acronyms and DefINItiONS .........ccueeeriiieiiieeiiieeiiee et e e eieeesieeesteeesaeeeseaeeensseeessseeesseesnnneens 4
1.2 Conventions Used in This Manual............ccccceooiiiiiiniiiiiiniiieeniceeeeeeeeesee e 4
1.3 Document OTZanizZatiOn ........c.ceeeveeeruieeerieeeiiieeesiieeasireessseeessseeesseeesseeessseesssseeessseessssessssseens 5
L4 GettiNg HEIP . .eeooieiiieieee ettt ettt e et e et e s s 5
2 Overview of DevCom2000 MODILE .......ccccuiiiiiiiiiiiiieeieete ettt 6
3 SyStem REQUITEIMENLS. ...ccouiiiiiiieiiiie ettt ettt et e st e et eeesabeeeabeeesabeeesteesbbeesabneesanees 7
4 DevCom2000 Mobile INStallation.......ccc.eeetiiiiiiiieiierieeiee sttt ettt 8
4.1 PIOTEQUISIIES . .eeeeuiiieiiieeeiiee ettt e ettt et e ettt e et e ettt e s bt e e eabb e e e bt eesabeeesabeeesabaeesnbeessseesnnseesnneens 8
4.2 Installing the DevCom2000 Mobile AppliCation...........cceeerueeeeiuieeniiieeniieenreeerieeesiveeeeeenn 8
4.3 Activating DevCom2000 MODILE.........ccccueiiriiiiiiiiiiiieeieeeteeete et 9
4.4  Bluetooth Settings on the MODIIE .........cccueiiiiiiiiiieiiieceeceeee e e 12
4.5 Connecting to the HART NetWOrk ......cccccoiiiiiiiiiiiiiieeeeeee e 15
4.6 Uninstalling the DevCom2000 Mobile AppliCation..........ccccveeeruereeieeeniieerieeerieeesevee e 15
S Using DevCom2000 MODILE .....ccccuuiiiiiiiiiiiieiieeeteeee ettt ettt esireesaree e 17
5.1 Starting DevCom2000 MODILE.......ccueeeiuiieriiiieiiieeciie ettt saeeesaee e reeeaaeeeaneeas 17
5.2 Getting Familiarized with DevCom2000 Mobile EXplOrer .........ccoccceeeerieiieeniienneennennne. 19
6 Functions and BasicC OPeTrations..........c..eeiueeeriiieeiieeeiiieeeieeesieeesiteeesseeessseeessseeessseeessseessssesssssesnnns 22
0.1 OVEIVIEW ..ttt ettt et st ettt st e sat e et e sae e e be e st e e eesaneeanee 22
6.2 Viewing Device Configuration (typical, actual view may change based on DD)............. 22
6.3 Configuring Device Information...........ceeeviiiiiiiiiiiieiiiie ettt 24
6.4 Calibrating HART Field DeVICES.......ccvcuiiiiiiiiiiieieiie ettt 33
6.5 Viewing the Device and Communication Status ............ceeveeerriieeriieeeriieeenieeeneeeeieeeeieens 33
6.6 Saving Device Configuration TO MEmMOTY .......cccceevvieeriieeiiieeiiieeieeeeieeesieeesreeesveeeaneens 35
6.7 PC Interface t0 MODIIE.......coceiriiiiiiiiiiecee e 36
6.8 DD Library UPdates.....ccueeeeuiiieiiieeiiieeiieeeiteesteeeevteesiteeeseteeeeteeeseeessaeessseesssseesnsseeensseens 37
Appendix A TroubleshOOting GUIAE .........ccccueeiiiiieiiiieeieeeiee et rre e eare e eaee e e aeeesaeeeenns 36
Appendix B Mobile Data INput GUIAE .........eeeriiiiiiiiiiiiiiieieeeteeee ettt 37
Appendix C Contact INfOrmation..............oouiiiiiiiiiiiii et 39
MAN-1017 8/9/2011 Our Quality Management System is Page 3

ISO 9001:2008 Certified



\,; PROCOMSOL

Process Communications Solutions

DevCom?2000 Mobile User Manual

1 INTRODUCTION

The Smart Device Communicator (DevCom2000 Mobile) allows access to and management of a HART compatible

field device's configuration and calibration. This manual provides the information about the Hardware setup,
Communication with Smart devices, and functions of DevCom2000 Mobile.

DevCom2000 Mobile is unique in that it uses the DD of the connected device to determine what information to
display, what variables are available for edit, and what procedures to follow for calibration, setup, and maintenance.

1.1 Acronyms and Definitions

Acronym Definition

DD Device Description File. This contains the device
information.

DDL Device Description Language

HCF HART Communication Foundation

DevCom2000 Mobile Smart Device Communicator

1.2 Conventions Used in This Manual
Following formatting conventions are used in this guide:

Convention Description

Words in bold type Field names including buttons in the display,
or important phrases.

- Arrow Windows pull down menus and their options

Courier font

UPPERCASE

UPPERCASE within
angle brackets

are separated by >

For example, click Device - New Device to
connect to a new device.

Information that you type, parts of the code
quoted for explanations or as examples.

Acronyms

Command keys
For example, press <ENTER>.
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1.3 Document Organization
DevCom2000 Mobile user manual is organized into the following sections:

Section 1 Describes the scope and objective of DevCom2000 Mobile
user manual along with the organization of the remaining
part of the manual.

Section 2 Provides an overview of the DevCom2000 Mobile
application and its architecture.

Section 3 Provides the information pertaining to hardware and
software requirements for the DevCom2000 Mobile
application.

Section 4 Provides the steps to install, activate, and uninstall the
DevCom2000 Mobile application.

Section 5 Provides the steps to start the DevCom2000 Mobile
application and connecting to field devices.

Section 6 This section explains different aspects of the DevCom2000
Mobile application and its functionalities.

1.4 Getting Help

If you need help or encounter problems when using DevCom2000 Mobile or this guide, please contact ProComSol,
Ltd. See Appendix C for contact information. Please provide the following information.

Create a text description of the problem. If possible, provide the text in event sequence, which will enable
the duplication of the problem. Provide information about the system. This information must include:

e  DevCom2000 Mobile version and serial number

® Mobile information: make, model, and operating environment (Windows version)
e Device information: make, model, and device revision

e Point of contact: complete mailing address, telephone number, and e-mail address,

¢ The date and time of the problem occurrence.
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2 OVERVIEW OF DEVCOM2000 MOBILE

Field devices such as flow, pressure, level, temperature transmitters, and valve positioners provide the physical
connection to the process. These devices allow the control system to monitor and manipulate process conditions.
HART devices maintain a real-time database of process, configuration, identification, and diagnostic information.
This information can be accessed using the HART Field Communications Protocol.

HART devices are capable of providing functions and features far beyond the basic task of providing a process
input or accepting a control output to manipulate process conditions. Many HART compatible device manufactures
create a DD (Device Description) describing all of these functions and features specific to that device. The DD also
provides information essential to the successful configuration and calibration of the device.

DevCom2000 Mobile uses these DD’s to access the data stored in a device, providing full configuration and setup
support for all registered HART DD’s.

DevCom2000 Mobile accesses and presents field device data based solely on its DD. No other files, information or
custom drivers are required. DevCom2000 Mobile is intended to monitor and configure a single device at a time, it
is directly connected to the current loop of the particular device and:

¢ Provides user interface to configure the HART field device,
® Provides a means to configure and view all the parameters related to HART field device, and
® Provides an option to view the detailed status and diagnostic capability of the device.

DevCom2000 Mobile allows viewing and modifying of field device parameters based on the DD. Using the
device’s DD, DevCom2000 Mobile performs various tests to verify the proper operation of the HART device.
DevCom2000 Mobile runs as a standalone software package and must have a HART compatible modem attached to
the system to interrogate the HART base devices.
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3 SYSTEM REQUIREMENTS

The following minimum system requirements are recommended for operation of DevCom2000 Mobile.

Mobile Device Processor Speed: 624 Mhz
Memory RAM: 128 MB

Memory ROM: 256 MB
Screen: 256-color VGA

SD Card or Micro SD Card Slot

SD Card 500 Meg or greater (included with software)
HART Modem Bluetooth to HART modem - ProComSol,
Ltd supplies HART modems
Communication Port Bluetooth
Operating System Pocket PC 2003, Windows Mobile 5.0,
Windows Mobile 6.x
MAN-1017 8/9/2011 Our Quality Management System is Page 7
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4 DEVCOM2000 MOBILE INSTALLATION
4.1 Prerequisites

You need to be familiar with the basic functions of the following when installing the DevCom2000 Mobile tool:
e Microsoft Windows
¢ HART communication interface
e HART field device

e Mobile Syncing using Windows ActiveSync

4.2 Installing the DevCom2000 Mobile Application
To install the DevCom2000 Mobile application, perform the following steps:

Step  Action

1 Insert the DevCom2000 Mobile SD Card into the SD slot of the
Mobile device. Connect the Mobile to your PC and verify the
ActiveSync program is running. :

2 Note: The step in this paragraph is only required if the SD Card
is not supplied, but instead the DD Library is supplied as a
program install. When the DD library update is installed, it is
placed in the “C:\HCF\DDL\Mobile\Library” directory on the
PC. Copy the Library folder to the SD Card on the Mobile so
that the path appears as “SD Card\Library”. Please note that on
some Mobile devices “SD Card” may have slightly different
text. (Note: You will overwrite the existing SD Card\Library
subdirectory if this is an update.)

3 Insert the DevCom?2000 Mobile CD into the CD-ROM drive.
Auto run should begin installation, if not:

4 Click Start and choose Run. From the Run window, click
Browse.

5 In the Look In box, browse to your CD drive.

6 Double-click the drive to access the CD content.

7 Look for the setup.exe file and double-click the same. This
process will take you through a sequence of installation wizard
steps.

8 Follow the instructions on the upcoming screens to complete the
Installation.

9 Once completed on the PC, a step remains on the Mobile. Select

the “Device” option on the screen below:
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Step  Action

oF {x12:36

Choose a location to install "ProComSol
DevComZ2000 Mobile":

@ [Device|

(O \sD Card

(O \iPAQ File Store

Space Needed: 6059 KB
Space Available: 143846 KB

Install

4.3 Activating DevCom2000 Mobile

DevCom2000 Mobile must be activated for continued use. If the program is not activated, it will not run after 10
days. The following procedure will activate the software:

Step  Action

1 Start the DevCom2000 Mobile Application. The following
Demo mode window is displayed:

7s  DevCom2000 a 4x 4:34

Demo mode. You have 10
days left.
Activate Now?

Yes No

. LT et =
=
96% 76.30MB 1.71GB

iPAQ Wireless 2] ,_T_:«

Calendar Contacts
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Step  Action

If you want to evaluate DevCom2000 Mobile before purchasing,
select “No”. You will have 10 days of unlimited program use
before you will need to purchase a license.

2 If “Yes” is selected, the following window appears:

" Activation ¥ 4x 4:37 ok

Provide these codes to ProComSol:

Enter keys below to activate:

SN: | |

Phone: 216.221.1550

Email: support@procomsol.com

Activate Cancel

You will then need to contact ProComSol, Ltd to obtain the
registration keys. You must supply the User Codes to
ProComSol, Ltd support personnel. You can activate in any of
the following ways:

1. Call ProComSol, Ltd at 216.221.1550. Have the program
Serial Number and User Codes ready.

2. Or, send an email to support@procomsol.com containing your
company name, Serial Number, and User Codes.

3. Or, send a fax to ProComSol, Ltd (216.221.1554) containing
your company name, Serial Number, and User Codes.

The above information will be processed at ProComSol, Ltd and
an appropriate response will contain the required Reg Keys. The
user will need to enter the Reg Keys and the Serial Number.

If successful, the program continues as normal. You will not
need to perform the activation process again.

3 We have tried to make the Activation process as easy as
possible. Contact ProComSol, Ltd if you have any difficulties

4 On some Mobile devices another step is required in order to
select the DD library location. This is only required if the SD
card has a name that is not standard. In this case a screen will
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Step  Action

come up where the user will need to select the path of the DD
Library in the Mobile device. The selection will appear in the
box at the bottom of the screen.

7 | Online browse o 4x12:58 lok

Select DD Library Location

-1 Mabile Device

[»

Application Data
ConnMgr

Documents and Settings
iPAQ File Store

My Documents

Program Files
-- 5D Card

- [

Temp

11

Windows

|SD Card\xLibrary |
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4.4 Bluetooth Settings on the Mobile
Bluetooth must be enabled on the Mobile. To enable and setup the Mobile for Bluetooth communications with a
Bluetooth HART Modem, perform the following.

Step  Action

1 Tap Start > Settings. Then select the “Connections” tab. The
following screen is displayed:

o 4E 354 €D

s |
=

Beam Bluetooth BT Phone
Manager
W [0 &
Connections iPAL) LEAP
Wireless

Ej‘“

Metwork
Cards

Personal | Swsken | Connections |

E|A

2 Select the Bluetooth icon. Make sure Bluetooth is turned on. If
not, select “Turn On” from this screen:

Bluetuuth Settings o ¢ 3:54 ()

Bluetooth: General

Current profile

T | 5)

Bluetooth status
Bluetooth is ON

Ilse the Bluetooth Manager ko sek connections.

aceneral | Accessibility | Services | About |

E|A
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Step  Action

3 Select the “Accessibility” tab and verify the following settings:

Bluetnnth Settings o} ¢ 3:56 (9

Bluetooth: Accessibility

Device Identification

Mame: |F‘|:u:kEI:_F‘C

Address;  03;00:37:03:F5:.EE

Use PocketPC device name For
Blustooth

Accessibility
#llow other devices to conneck
@ All devices

{ ) Paired devices only
Other devices can discover me

General | Accessibility | Services | About |

|
4 Select the “Services” tab and verify the following settings for
Serial Port:
Bluetuuth Settings o ¢ 3:55 ()
Bluetooth: Services
Services
1T File TransFer -
iﬁlnfnrmatinn Exchange =
i Serial Port —
%F‘ersnnal Metwork Server -
Service settings
Enable service
|:| &utharization required
Authentication {Passkew) required
Encryption required
General | Accessibilicy | Services | About |
=]
5

Select the “Advanced” tab to see what outgoing COM port was
assigned to the Modem. It is shown as COMS below. Also
make sure the box is unchecked as shown:
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Step  Action
Bluetuuth Settings oF ¢ 3:55 (D)

Bluetooth Serial Port settings

Ports

Inbound COM Part:
Cutbound COM Pork;

D Default device for outgoing serial
connections: HART Modern, Display
the device selection screen the
rext time an outgoing setial

connection is atternpted.
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4.5 Connecting to the HART Network

The DevCom?2000 Mobile application communicates with the HART Field Devices through a HART compatible
communication interface (e.g., a "HART Modem"). Using this communication interface you will transmit real-time
HART data between DevCom2000 Mobile and the connected HART compatible field device.

There are a wide variety of HART compatible interfaces. Please follow the manufacturer’s instruction for
connecting your interface to the Mobile. This manual uses the HART modem manufactured by ProComSol, Ltd,
called the HM-BT-BAT-ER. It uses the Bluetooth interface.

Turn the HM-BT-BAT-ER on. It is assumed you have already performed the Bluetooth pairing procedure. See the
HM-BT-BAT-ER documentation for details. Using the clips on the wires from the HART modem, connect to the
device across the 4-20ma signal. If a suitable load resistance is not available, a 250Q2 resistor must be placed in
series with the device power supply.

Figure 1 Typical DevCom2000 Mobile Hardware Setup

4.6 Uninstalling the DevCom2000 Mobile Application
To uninstall the DevCom2000 Mobile application, perform the following steps on the PC:

Step  Action

1 Click Start 2 Programs > ProComSol - DevCom2000
Mobile - Uninstall DevCom2000 Mobile

2 Or, Click Start - Settings > Control Panel > Add/Remove
Programs

MAN-1017 8/9/2011 Our Quality Management System is Page 15
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Step  Action

3 In the Add/Remove Programs dialog window, select the
DevCom2000 Mobile program that you want to uninstall.

4 Click Remove.

Click OK to confirm the removing of the selected application.

MAN-1017 8/9/2011 Our Quality Management System is Page 16
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S USING DEVCOM2000 MOBILE

5.1 Starting DevCom2000 Mobile

The HART compatible field device must be connected to a Mobile running DevCom2000 Mobile to configure or
calibrate the field device, or to view the field device's data. Make sure to establish the physical connection between
the field device and the DevCom2000 Mobile computer. With the physical connection established, launch
DevCom2000 Mobile by clicking the DevCom2000 Mobile icon on your program screen. You can also start the
application by going to your Mobile's Start Menu and selecting Start > DevCom2000 Mobile.

Step  Action

1 Start the DevCom2000 Mobile Application. The following
application window is displayed:

ot < 10:44

AR Al A

Itern Walle | Units
Ready H&RT |
Device Yiew Help E|*

DevCom2000 Mobile will then automatically identify the field
device and open a communication channel to (i.e., a connection
with) the field device.

2 Setting Preferences Device = Preferences

If communications cannot be established, you may need to
change the communication settings using the Preferences dialog
box.

The serial port box will show the available com ports. Select the
one your HART modem is using. You may also change the
polling options for the computer. If you do not know the poll
address of the device you are trying to communicate with, use
the default address O setting.

MAN-1017 8/9/2011 Our Quality Management System is Page 17
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Step  Action

H o 42 10:25
Serial Port Preferences

Serial Port:  |COMS -

rSearch by Poll Address

@ use poll address 0 only
() find First poll address

O use poll address;

3 When the device is connected to DevCom2000 Mobile, the
browser window appears with online (i.e. root menu) selected.

o} oz 10:26

EH:I Device setup
{1 Process variables
-] Diag/Service -

#-{_] Basic setup -

#-{] Detaled setup -

Itern | Walue | Units

| 1] Device setup

oy 0.03 psi

ik A0 4,000 ma

iy LRY 0.00 psi

5y URY 599,99 psi
Ready HART

E|A

Device ¥iew Help

The top pane of the window shows the menu structure and the
bottom pane of the window displays corresponding parameters
of the menu selected.

The DevCom2000 Mobile screens shown in this document are
only an example of what you may see when connected to your
field device. What you see is actually controlled by the DD and
the device. The menus, data, status and configurations displayed

MAN-1017 8/9/2011
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Step  Action

are specified by the field device's manufacturer in the DD itself.

4 Select the required menu to configure or review the field

device's data.

5.2 Getting Familiarized with DevCom2000 Mobile Explorer

5.2.1 Using the Menu Bar Menus

DevCom2000 Mobile Explorer provides visual representation and structure of the application window.

Menu Explanation
New Device The Device Menu offers the following
Preferences

Document Device
Exit

v Toolbar
v Status Bar

Device Condition
Available DDs

DeyComz2000 Help
Device Help
About DeyCom2000 PDA

sub-menu options:

New Device - Connect to a new device or
reconnect to the same device.
Preferences — Brings up the Preferences
dialog box.

Document Device — Brings up the
Document Device dialog box.

Exit - Exit DevCom2000 Mobile.

The View Menu offers the following sub-
menu options:

Toolbar - Hide or show the Tool Bar.
Status Bar - Hide or show the Status Bar.

Device Condition — View detailed device
status.

Available DDs — Shows what DDs are
available to DevCom2000 Mobile

The Help menu offers the following sub-
menu options:

DevCom2000 Mobile Help — Brings up
Help information for the DevCom2000
Mobile application.

Device Help — Brings up help information
for the connected device (if available).
About DevCom2000 Mobile — Shows
copyright information, support
information, and application Serial
Number.
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5.2.2 Using the Pop-up Menus

When you tap and hold a menu item, a Pop-up menu will appear with different functionality depending on what
menu item type was selected. A summary:

Menu Explanation
Open The Menu Pop-up Menu offers the
Help following sub-menu options:
Device Details Open — Opens the selected menu.

Help — Brings up help information on the
selected menu.

Device Details — Brings DD information

for the connected device. Only works on
the Online menu.

Edit The Variable Pop-up Menu offers the
Help following sub-menu options:
Display¥alue Edit — Brings up the Edit menu for the

selected variable.

Help - Brings up help information on the
selected variable.

Display Value — Shows the selected
variable on the full screen with scroll bars.
This is so the entire variable can be seen
without abbreviations.

Execute The Method Pop-up Menu offers the
Help following sub-menu options:

Execute — Starts the selected Method in a
new window.

Help — Brings up help information for the
selected Method.

5.2.3 Using the Toolbar

When you start the application, by default, the toolbar buttons appears on the main window. If it fails to display,
click View = Toolbar option from the menu bar to bring up the toolbar.

Following are the buttons available in the DevCom2000 Mobile application toolbar to perform the necessary tasks:

Button Description Corresponding Menu Option
%ﬁ- Connect to a new device Device > New Device
ﬁ Send parameter changes to the
device
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Button Description Corresponding Menu Option

ﬁ Cancel parameter changes

@ View more status on Device View = Device Condition

and Communication
(Command 48 status)

‘? Shows About screen Help - About

5.2.4 Familiarizing with Icons

DevCom2000 Mobile application uses different icons to represent different elements of the application. Following
table lists the icons and their meanings:

Icon Meaning
(== Indicates a menu or submenu in the navigation tree
.ﬁ Indicates a currently selected menu or submenu in the
navigation tree
Q—;‘. Online menu icon. The actual DD menu comes under this.
(i Indicates a “Variable” item
(y Indicates a “Method” (Standard Operating Procedure) item
E)y Indicates an “Edit Display” item
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6 FUNCTIONS AND BASIC OPERATIONS

6.1 Overview

DevCom2000 Mobile allows the user to monitor and configure a single device at a time in the field. Each device is
associated with the DD when the device information is present. A DD may contain any of the following
parameters/elements:

Variable

A variable is defined as the data contained in the device (e.g. Device Firmware Version). There are two types of
variables:

Editable Variable — It allows the operator to modify the value and download it to the device.

Non-Editable Variable — It is a read-only data from the device.

Edit Display

This option is used to view a group of parameters. You can also modify a single parameter from this group, based
on which other parameters of the device get altered.

For example, if the Engineering Unit of the device is modified, the corresponding Low Limits and High Limits
change as per the Engineering Unit set.

Method / Standard Operating Procedure (SOP)

This option helps to perform various tests on the device for instance, Self Test and Loop Test. A Method or SOP is
a series of steps that are executed in a sequence results in the completion of some device related tasks. When a
method gets invoked, it gives various warning messages and options to the user, by which the user can thoroughly
test the device. If a test is aborted by operator command at any stage of the sequence, the method invokes
additional steps to bring the device back to its original state before the test.

6.2 Viewing Device Configuration (typical, actual view may change based on DD)
To view the configuration of the device that is connected to DevCom2000 Mobile, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:
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Step  Action

ot < 10:26

EH:I Device setup
{0 Process variables
#-{_] Diag/Service -

&7 Basic setup L

-] Detaled setup -
Item I Walue | Units
| ] Device setup
iy P 0,03 psi
iy A0 4,000 ma
5y LRY 0.00 psi
5y URY 599,99 psi
Ready H&RT |
Device Yiew Help E|*

The top pane of the window shows the menu structure and the
bottom pane of the window displays corresponding parameters
of the menu selected.

The menus are displayed depending on the type of device that is
being connected. These menus are displayed based on the DD
file of the particular device.

If no DD is available for the device the DevCom2000 Mobile
will select the standard DD. This should provide limited
functionality for the device. NOTE: If a parameter is updated
that is not supported by the device you will receive an error.

2 Expand the menu by clicking the “+” sign and double-click to
view the device parameters. Below is an example of an
expanded menu:
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Step  Action

ot o< 10:54

kRl JI
=88 Online
= Device sstup
{0 Process variables
=0 DiagfService
- B0 Test device

[ [

 #{3 Calbration
-] Basic setup

o B s Y P PN | F

1]

Item I Walue | Units
iy Status group 1 D00
iy Status group 2 D00
iy Status group 3 200
Ready HART Msg |
Device Yiew Help E|*
3 Select the menu and view the associated parameters to view the

device information.

6.3 Configuring Device Information
6.3.1 Overview

DevCom2000 Mobile allows you to view and configure the field device parameters based on the device description.
However, the device vendor defines most of the parameters at the factory. These parameters become read only for
the users and the user cannot modify the values. The related variables are grouped under various menus of different
levels as defined in the DD file. Expand or collapse the tree view using the “+” or “-*“sign to access the device
configuration parameters.

Following table describes the details about the device configuration:

Step  Action

1 Ensure that the application is running and communications have
been established:
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Step  Action

ot < 10:26

EH:I Device setup
{0 Process variables
#-{_] Diag/Service -

&7 Basic setup L

-] Detaled setup -
Item I Walue | Units
| ] Device setup
iy P 0,03 psi
iy A0 4,000 ma
5y LRY 0.00 psi
5y URY 599,99 psi
Ready H&RT |
Device Yiew Help E|*

The top pane of the window shows the menu structure and the
bottom pane of the window displays corresponding parameters
of the menu selected.

2 Expand the menu by clicking the “+” sign and double-click to
view the device parameters.

3 There are three types of variables: dynamic, read/write and read
only. The parameters that are grayed out indicate that these are
dynamic variables (variables that get updated online by the
device) or read only variables.

Following points describe how the device parameters represents
their status when connected to DevCom2000 Mobile:

Bold Font: Modifiable Values
Normal Font: Menu Item

4 Select the parameter and configure the values, as required.
The subsequent topics explain how to configure device
parameters.
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6.3.2 Variable

To edit the parameter variables of the connected device, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have

been established:

s
4

o< 10:26

AR AL AR

=

B

Mair
=EOrline
=+ Device setup
{1 Process variables
-] Diag/Service
-] Basic setup
H-{] Detaled setup

[ »

Item

| Walue | Units

Ly P

| 1] Device setup

iy A0
iy LRY
5y URY

0.03 psi
4,000 ma
0.00 psi
599.99 psi

Ready

HART |

Device ¥iew Help

E|A

Expand the menu by clicking the “+” sign and double-click to
view the device parameters.

2 Select the menu where the editable parameter is present as

shown below:
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Step  Action

i3
dan

2ED (B2

o< 11:20

=88 Online

= Device sstup
{0 Process variables
#-{_] Diag/Service

&7 Basic setup

{11 Sensors
ER=}ional condition

[T

EH:I Detaled setup —

3

Item I Wallie | LInits

2 Tra... Linear
'@‘ Damping 1.60 s

U_E Snsr temp unit C
i WFLY

4] n

[[*]

ERIN

Ready H&RT

Device ¥iew Help

]
F

3 Tap and hold the variable to edit it. A pop-up menu will appear

on the screen:

4 Select “Edit”.

g

AR AL A

o< 11:21

=29 Online

=+ Device setup
{1 Process variables
-] Diag/Service

#-{_] Basic setup

H-{] Sensors

[]*

EH:I Dietailed setup —

. --ﬁ Signal condition
Item | Wallie | LInits [«
U_Fﬁ Tra... Linear ||
5y Snsr kem C 21
i A Hel ||
< Di IJ| val -
isplay¥alue
Ready Ty |
Device ¥iew Help E|*

The following dialog box appears on the screen:
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Step  Action

o 2 11:22 (D

Damping: 1.60 =

1.60 |

Set Cancel

E|A

5 Tap the Keyboard icon to bring up a keyboard for data entry.
The screen will now look like this:

m o 21122 D

Darping: 1.60 s

|L.60 |
Set Cancel
123)1[2]3]4]|5]6|7][8][00]-[=]«

Tabjg[wle[r[t[yJuli[o]p[L[]]
CAP[a[s[d[f]a[h[j[k[I];]"
shift[z [ [c[v[b[n[m[,[. [/
ctfaia] " [\] [4]1]

|
—

[

—

g

Note that there are several ways to enter data using the Mobile.
See Appendix B for more options.

6 Make the changes to the parameter value, as required.
7 Click Set to accept the changed value. The change gets reflected
as shown:
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Step  Action

ot < 11:23

2P| ?
=88 Online

= Device sstup
{0 Process variables
(] Diag/Service
-] Basic setup
=0 Detailed setup —
- B Sensars
ER=}ional condition

Item I Wallie | LInits

2 Tra... Linear
'@‘ Damping b.40 5

U_E Snsr temp unit C
i WFLY
1] i [T+

Ready H&RT

Device ¥iew Help

Il [Tw

3

ERIN

]
F

8 Click on the Send icon B to commit the changes to the device.

6.3.3 Edit Display

The Edit Display is a variation on the Variable edit. An additional window helps the user view a group of
parameters based on the DD. You can also modify a single parameter from this group. Parameters linked to the
edited field will be updated automatically

To view and configure these variables, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established
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Step  Action

ot o< 10:26
e (2| ?
= Main "
EE‘F—" Cirlire -

EH:I Device setup
{1 Process variables
-] Diag/Service -

#-{_] Basic setup -

#-{] Detaled setup -
Item | Walie | Units
| 1] Device setup
oy 0.03 psi
iy A0 4,000 ma
iy LRY 0.00 psi
5y URY 599,99 psi
Ready HART |
Device ¥iew Help E|*

Expand the menu by clicking the “+” sign and double-click to
view the device parameters.

2 Double click the parameter you wish to edit. The following
dialog box appears on the screen:

ot dé 256
-Edit Display

Item | Walue | Lpits |
My LRY 599,99 pfo
@4 LR 0.00 psi
oK Cancel

|

3 Double click the parameter you wish to edit from within the Edit

Display box. The following dialog box appears on the screen:
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Step  Action

LIRW: 599,99 pfs
509,99 |
Set Cancel
|«
4 Make the change to the value, as required.

Click Set to accept the changes. Or press Cancel to cancel the
changes.

6 Click OK to close the Edit Display dialog box.

7 Click on the Send icon B to commit the changes to the device.

6.3.4 Executing Methods or Standard Operating Procedures

Methods are defined in the DD file for the device that DevCom2000 Mobile is connected to. You can select the
Method and execute it for calibrating the device, trouble shooting, etc. Method execution leads you through a
number of steps, like in a wizard.

A Few examples of methods include,

Setting high and low range calibration points
Calibration of the device

Run the advanced diagnostic test procedure

Execute tests to gather information on device operation.

To execute a Method, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:
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Step  Action

ot o< 10:26
e (2| ?
= Main "
EE‘F—" Cirlire -

EH:I Device setup
{1 Process variables
-] Diag/Service -

#-{_] Basic setup -

#-{] Detaled setup -
Item | Walie | Units
| 1] Device setup
oy 0.03 psi
iy A0 4,000 ma
iy LRY 0.00 psi
5y URY 599,99 psi
Ready HART |
Device ¥iew Help E|*

Expand the menu by clicking the “+” sign and double-click to
view the device parameters.

2 Select the menu where the method is present and tap and hold to
bring up the Method pop-up menu:

H +F «< 3:06
2T (@ ®

0 Output condition |

({7 Process variables
alog output
- HART output

i -7 Meter ontinns
4] i [ [*

AN

Item | Walie | Units
Wy Loop ta
iy D8 t
mly Sealed
N AeFATETT Hi

Execute

Ready HART |
Device ¥iew Help E|*

3 Select Execute to start the Method. Below is an example of a
Method screen:
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Step  Action

Press OF butkon bo continue method
excecukion or Abark butbon bo abork

[ ok ] | #bot | | Help |

E|A

4 Click OK to move to the next dialog in the Method sequence.
Or, click Abort to cancel the Method execution.

6 Click Help to get specific help for that step of the Method. This
Help information is provided by the device DD.

6.4 Calibrating HART Field Devices

Calibration of field devices and loop test are achieved by executing the Methods or Standard Operating Procedures
that are specific to device. Methods are defined based on the test parameters specific to the device, providing
information for the calibration of that device.

See the previous section for Method execution.

6.5 Viewing the Device and Communication Status

DevCom2000 Mobile provides the user with the ability to monitor the device specific status of the device and the
communication network.

When there is error communicating with the device, it is recognized and indicated to the user. The user can view
more details of such errors, using the View = Device Condition from the main window.

To view the device and communication status, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have

MAN-1017 8/9/2011 Our Quality Management System is Page 33
ISO 9001:2008 Certified



\,; PROCOMSOL

Process Communications Solutions

DevCom?2000 Mobile User Manual

Step  Action

been established:

ot < 10:26

(] Process variables

-] Diag/Service -
#-{_] Basic setup L

-] Detaled setup -
Item I Walue | Units
| ] Device setup
= 0,03 psi
iy A0 4,000 ma
5y LRY 0.00 psi
5y URY 599,99 psi
Ready H&RT |
Device Yiew Help E|*

Expand the menu by clicking the “+” sign and double-click to
view the device parameters.

2 Select View - Device Condition from the main window or
choose the status icon & from the toolbar. Following window is

displayed:

o 2327 D

C o o oo

YWertical Parity errar
Crwerrin errar

Framing errar
Longitudinal Parity error

Buffer overflow

Comrmunication Status | Device Skakus | E:d 4

Device ¥iew Help

E|A

The Device Status tab option shows the status of the device and
the communication network. The individual status is indicated
by green and red LEDs.
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Step  Action

3 Additional tabs may be available depending on the DD. Tap the
arrow buttons to move amongst the tabs.

4 Click X to close the Status window.

6.6 Saving Device Configuration To Memory

HART Device configurations can be saved to memory as a text file to document the device. Fields are delimited
with a comma so that the data can be imported into configuration management software packages.

To save device configurations to disk, perform the following steps:

Step  Action

1 Ensure that the application is running and communications have
been established:

H oF o< 10:26

n
s
=
]
=
[ »

EH:I Device setup
{1 Process variables
-] Diag/Service -

#-{_] Basic setup -

#-{] Detaled setup -
Itern | Walue | Units
| 1] Device setup
oy 0.03 psi
iy A0 4,000 mb
iy LRY 0.00 psi
5y URY 599,99 psi
Ready HART |
Device ¥iew Help E|*
2 Select Device =2 Document Device from the main window.

The Document Device Dialog Box is displayed:
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Step  Action

File Marne:

YWy Documents\HART C| [Browse

Motes:

Erter notes here...

I

4]

Save Device Config

Exit

E|A

3 The default directory is \HART Configs. The default file name
is Tag_Device ID. The filename can be changed by the user.
Use the “Browse” button to change directories and/or filenames

also.

4 Enter a Note in the Notes field if desired. Maximum of 255
characters.

5 Press the “Save Device Config” button to save device
configuration.

6.7 PC Interface to Mobile

The Windows Explorer program is a convenient way to copy configuration files back to the PC for archiving and
storage. The Mobile looks like a disk to the Windows file system. Below is an example screen shot:
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@ My Documents\HART Configs

File: Edit ‘“iew Favortes  Tools  Help

=10ix]

-a
| &

@Back - \,_—.-J T .?

f"_] Search H; Falders

i 3 X 9| @

Address |[ ) \My DocumentstHART Configs

EE

Folders

b

=] Q Mobile: Device
= [J My Windows Maobile-Based Device
[#] Databases
I ConnMgr
|5 iPad File Stare
[0 My Documents
& 13 OLDREL
i) profiles
I=) Program Files
I 50 Card
# [ Library
1) Temp
=) Windows
H (L) Business
M [ Dictionaries
{23 HART Configs
[ My Music
H [ My Fictures
M [ Personal
| Templates

|

=

| Mames = I Size | Tvpe I Modified |
E] P-101 _F35012... 1.86KE  Text Document &/18/2008 5:04:35..,
|E:| kesk, bk 1.82KE  Text Document 6/11/2008 1:29:48...
EI besk2 bxk 1.87kB  Text Document 6112008 1;54:06,.,

The default location for the saved configuration files is the directory “\My Documents\HART Configs”. Simply
highlight the desired files and copy to your PC. Once on the PC, they can be viewed or imported to many different

software packages.

6.8 DD Library Updates

When the DD library update is installed, it is placed in the “C:\HCF\DDL\Mobile\Library” directory on the PC.
Copy the Library folder to the SD Card on the Mobile so that the path appears as “SD Card\Library”. Please note
that on some Mobile devices “SD Card” may have slightly different text. (Note: You will overwrite the existing SD

Card\Library subdirectory.)
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Appendix A

Troubleshooting Guide

Problem:
Will not communicate

Hardware Check:

Verify the following:

1. Com port number on Preferences Dialog box matches HART interface hardware.

2. Loop power supply is on.

3. Loop resistance between 250 ohms and 1Kohms.

4. Loop current within HART limits.

5. If multi drop configuration, all transmitters in loop have unique addresses.

6. HART interface hardware connected across loop resistor or across transmitter terminals.

Problem:
Get the message “Error opening COMx”

Verify the following:
1. Com port number on Preferences Dialog box matches HART interface hardware.
2. HART interface hardware installed.

Problem:
The system cannot find the path specified error box

Try the following:
1. Verify that the DevCom2000 Mobile SD Card is inserted into the SD slot of the Mobile.
2. Select the path of the DD Library in the Mobile device when starting up DevCom2000 Mobile.

Problem:
Serial Number does not match Activation input boxes

Note the following:
1. The Program Serial Number is different than the Activation Codes.
2. Activation Codes required after 10 days of Demo program use.
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Appendix B

Mobile Data Input Guide

There are several different ways to enter data on a Mobile. Tap the up arrow next to the Input Panel icon. The
following will appear:

LR 589,99 psj
593.99 |
Set aNCe
Options...
Block Recognizer
* Keyboard
Letter Recognizer
Transcriber
]|
Keyboard

Use the stylus to tap letters, numbers, and symbols on the on-screen keyboard to enter typed text directly onto the
screen.

1. From any application, tap the up arrow next to the Input Panel icon.

2. Tap Keyboard to display a keyboard on the screen. Note: To see symbols, tap the 123 key.
3. Tap a letter, symbol, or number to enter information.

4. Tap OK.

Letter Recognizer

Use the stylus and Letter Recognizer to write letters, numbers, and symbols on the screen. Create words and
sentences by writing in uppercase (ABC), lowercase (abc), and symbols (123) as instructed here.

1. From any application, tap the up arrow next to the Input Panel icon.

2. Tap Letter Recognizer.

3. Write a letter or symbol between the dashed line and baseline.

- To display in uppercase, write a letter between the hatch marks labeled ABC.
- To display in lowercase, write a letter between the hatch marks labeled abc.

- Write a number or draw a symbol between the hatch marks labeled 123.
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What you write will be converted to text.

Note: For the Letter Recognizer to work effectively, write characters between the dashed line and baseline.

[13 2

- I you are writing a letter like “p,” write the top portion within the dashed line and baseline, and the tail portion
below the baseline.

- If you writing a letter like “b,” write the bottom portion within the dashed line and baseline, and the top portion
above the dashed line.

Note:To view help on using Letter Recognizer, open the program and tap the question mark next to the writing
area.

Transcriber
Use the stylus and Microsoft Transcriber to write words, letters, numbers, and symbols anywhere on the screen.

1. From any application, tap the up arrow next to the Input Panel icon.
2. Tap Transcriber to display the Transcriber Intro screen.

3. Tap OK.

4. Tap New at the bottom of the screen.

5. Begin writing on the screen. What you write will be converted to text.

Note: To “teach” Transcriber your style of writing, tap on the “a” icon at the bottom of the screen to display the
Letter Shapes screen and follow the instructions.

Block Recognizer

Write letters, numbers, and symbols using the stylus and Block Recognizer. Create words and sentences by writing
letters and numbers in specific areas.

1. From any application, tap the up arrow next to the Input Panel button.

2. Tap Block Recognizer.

3. Write a word, letter, or symbol between the hatch marks.

- To type text, write a letter between the hatch marks labeled ‘“abc.”

- To type numbers or symbols, write a number or symbol between the hatch marks labeled “123.” What you write
will be converted to text.
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Appendix C

Contact Information

ProComSol, Ltd

Process Communications Solutions
13001 Athens Ave

Suite 220

Lakewood, OH 44107

USA

Phone: 216.221.1550

Fax: 216.221.1554

Email: sales@procomsol.com
support@procomsol.com

Web: www.procomsol.com
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